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Objetivos de Aprendizaje

Al finalizar esta presentación, Usted podrá: 
• Entender conceptos básicos de la interferometría SAR y el rastreo de pixeles de 

SAR
• Describir lo que la fase de SAR interferométrico indica sobre la superficie terrestre y 

los deslizamientos
• Describir el procesamiento de datos necesario para crear un interferograma
• Entender la información que contienen las imágenes de SAR interferométricas

sobre el desplazamiento de tierra

https://arset.gsfc.nasa.gov/
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Prerrequisitos

• Conceptos Básicos del Radar de Apertura Sintética 2017
• Procesamiento y Análisis de Imágenes SAR 2017
• Introducción a la Interferometría SAR 2017

3

https://arset.gsfc.nasa.gov/
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Reconocimientos

• JPL: N. Pinto, Y. Zheng, P. Agram, E. Gurrola, equipo de procesamiento de UAVSAR
• NASA AFRC & JSC: J. McGrath, pilotos y personal
• USGS: J. Coe, W. Schulz
• UC Berkeley: R. Bürgmann, B. Delbridge
• U de Maryland: Mong-Han Huang
• Los programas NASA Earth Surface and Interior, Geodetic Imaging, NISAR Science 

Team
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https://arset.gsfc.nasa.gov/


Teoría Interferométrica de SAR (Repaso)
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Teoría de SAR Interferométrico

• Breve repaso de la teoría interferométrica del radar de apertura sintética
• Vea la capacitación ARSET de 2017 “Introducción a la Interferometría SAR” para 

más detalles
• En la interferometría SAR, lo más importante es la fase de la señal de SAR

https://arset.gsfc.nasa.gov/
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Fase SAR–Medida del Rango y de la Complejidad de la Superficie

0
1

2
…

La fase de la señal de radar es el número de ciclos de 
oscilación que la onda ejecuta entre el radar y la 
superficie y de regreso

La fase total es un rango bidireccional medido en ciclos 
de onda + componentes superficiales aleatorios

Número de Ciclos 
(¡en realidad millones!)

La colección de longitudes de trayectorias aleatorias 
confunde la fase del eco

¡Sólo la interferometría lo puede resolver!

Diapositiva modificada de  Paul Rosen (JPL)

https://arset.gsfc.nasa.gov/
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Una Visión Simplista de las Fases de SAR

Fase de la 1ra Imagen 

Fase de la 2da Imagen

1. Las “otras constantes” no se pueden determinar directamente

2. Las “otras constantes” dependen de la distribución de los dispersantes en la 
celda de resolución, la cual se desconoce y varía de celda en celda

3. La única forma de observar el cambio de rango es a través de la interferometría 
(cancelación de las “otras constantes”)

otras constantes

otras constantes

Diapositiva modificada de  Paul Rosen (JPL)

https://arset.gsfc.nasa.gov/
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Aplicaciones de la Interferometría SAR

Diapositiva modificada de  Paul Rosen (JPL)

• Mapeo/Cartografía
– Se utilizó la interferometría SAR en la misión Shuttle Radar Topography Mission (SRTM) en 

el año 2000. Los datos fueron reprocesados en el 2018 y esta nueva version se llama 
NASADEM y estan disponibles sin costo.

– La interferometría de radar en plataformas aéreas se utiliza frecuentemente para 
producir mapas topográficos conocidos como modelos de elevación digital (digital 
elevation models o DEMs)
• Exactitud de posición circular de 2 a 5 metros
• Resolución de 5 a 10 m
• Se producen DEMs de 10 km por 80 km en una hora en una mini-supercomputadora
• NASA produce mapas de topografía con SAR utilizando GLISTIN

– Las imágenes de radar se geocodifican automáticamente y así se pueden combinar 
más fácilmente con otros conjuntos de datos (multiespectrales)

– El mapeo rápido interferométrico facilita las aplicaciones topográficas
• Gestión y clasificación de usos del suelo, evaluación de riesgos, inteligencia, 

planificación urbana, geología a corta y larga escala temporal, hidrología

https://arset.gsfc.nasa.gov/
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Aplicaciones de la Interferometría SAR

• Mapeo de Deformaciones y Detección de Cambios
– La interferometría de radar de paso repetido desde plataformas espaciales se 

utiliza comúnmente para producir mapas de cambios topográficos conocidos 
como modelos de desplazamiento digitales (digital displacement models o DDMs).
• Tienen una exactitud de desplazamiento relativo de 0,1 a 1 centímetro
• Paso de muestreo y resolución de 10 a 100 m
• Se producen DDMs entre 10 y 350 km de ancho rápidamente una vez que los 

datos están disponibles
– Aplicaciones incluyen

• Monitoreo y modelación de terremotos y volcanes, derrumbes y subsidencia
• Dinámica de glaciares y la capa de hielo
• Deforestación, detección de cambios, monitoreo de desastres

https://arset.gsfc.nasa.gov/
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Interferometría Diferencial

• Cuando se obtienen dos observaciones desde el mismo punto en el espacio pero 
en momentos diferentes, la fase interferométrica es directamente proporcional a 
cualquier cambio en el rango de las características de la superficie.

Diapositiva modificada de Paul Rosen (JPL)

cambio

cambio

c

https://arset.gsfc.nasa.gov/
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Sensibilidades Interferométricas Diferenciales
• La razón por la que la interferometría diferencial puede detectar deformaciones superficiales 

a nivel milimétrico es porque la fase diferencial es mucho más sensible al desplazamiento 
que a la topografía.

Diapositiva modificada de Paul Rosen (JPL)

Sensibilidad Topográfica

Término de Sensibilidad Topográfica

Término de Sensibilidad al Desplazamiento

Ya que ==>

Mediciones Topográficas a Escala Métrica – Cambios Topográficos a Escala Milimétrica

Sensibilidad al Desplazamiento(φ  ∆φ)

sen

sen

d e s p

d e s p

sen

https://arset.gsfc.nasa.gov/
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Desenrollamiento de la Fase

• A partir de la fase medida y enrollada, desenvuelva la fase desde algún punto de 
comienzo arbitrario y después determine la “ambigüedad” de fase 2-pi correcta

Diapositiva modificada de Paul Rosen (JPL)

Fase real

Fase enrollada (medida)

Fase desenrollada 
típica

med

med

desenv

desenv

https://arset.gsfc.nasa.gov/
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Teoría de Correlación*

• Las señales InSAR se decorrelacionan (se vuelven incoherentes) debido a
– Ruidos térmicos y por Procesamiento
– Dispersión Diferencial Geométrica y Volumétrica
– Rotación de la Geometría de Visualización
– Movimientos aleatorios a través del tiempo

• La decorrelación está relacionada con la desviación del estándar de la fase local 
de la fase del interferograma
– Afecta la precisión de la altitud y el desplazamiento
– Afecta la habilidad de desenrollar la fase

*“Correlación” y “Coherencia” a menudo se usan como sinónimos
Diapositiva Modificada de Paul Rosen (JPL)

https://arset.gsfc.nasa.gov/
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Componentes Correlativos de InSAR

• Los efectos de correlación se multiplican, a diferencia de los efectos de fase que 
se suman

• Una baja coherencia o decorrelación por cualquier motivo causa una pérdida de 
información en esa área

γ= γv γg γt γc
donde
γv es volumétrico (árboles)
γg es geométrico (pendientes       

empinadas)
γt es temporal (cambios 
graduales)
γc es cambios repentinos

https://arset.gsfc.nasa.gov/
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Longitud de Onda:

La señal interactúa más con los objetos de  
tamaño similar a la longitud de onda

Bosque: Las hojas reflejan las 
longitudes de banda-X pero 
no las de banda-L

Hielo: La superficie y las capas 
se ven rugosas en la banda- X 
pero no en la banda-L

Suelos Secos: La superficie se 
ve rugosa en la banda-X pero 
no en la banda-L

L (24 cm) C (6 cm) X (3 cm)

Diapositiva Modificada de Paul Rosen (JPL)

https://arset.gsfc.nasa.gov/
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Detección de Cambios Coherentes

• Creación de interferogramas con imágenes separadas por 6 meses
• Bandas C y L simultáneas

Interferometría de SIR-C banda-L y banda-C

Los experimentos de InSAR han mostrado una buena correlación 
en la banda-L

https://arset.gsfc.nasa.gov/
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Seguimiento de Desplazamiento de Pixeles con SAR 

• Grandes desplazamientos de la superficie, más de aproximadamente 1/10 del 
tamaño de un pixel de SAR, causan una perdida de coherencia de InSAR

• Los deslizamientos y terremotos comprenden grandes desplazamientos
• El seguimiento del desplazamiento de pixeles o correlación de imágenes puede 

medir grandes desplazamientos
• Sirve para imágenes ópticas o SAR
• De manera similar a InSAR, mide los desplazamientos entre dos imágenes
• Los desplazamientos de pixeles de SAR miden deformación 2D diagonalmente a 

lo largo de la línea visual y horizontalmente a lo largo de la dirección del vuelo
• Por medio de una correlación cruzada precisa mide cambios en la amplitud de 

las imagenes a nivel del subpíxel

https://arset.gsfc.nasa.gov/
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Seguimiento de Desplazamiento de Pixeles con SAR 

• Ventajas:
• Mediciones en 2 dimensiones
• No hay límite en la magnitud de 

deformación que se puede medir (InSAR 
tiene límite)

• Mide un campo de deformación    
continuo

• Las nubes no son problemáticas
• Pocos o ningun efecto atmosférico
• Limitaciones:
• Sensibilidad a escala de centimetros a 

metros
• Vegetación
• Sesgo de observación Mapas de deformación

Leprince et al., 2007

https://arset.gsfc.nasa.gov/


Ejemplos de InSAR:
Deslizamientos en California, Oregón y 

Colorado
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Derrumbes en California

• Deslizamientos en la Serranía Costera de California:
– Las Unidades Litológicas Complejas Franciscanas son 

rocas débiles propensas a deslizamientos o derrumbes
– La actividad tectónica a lo largo del borde de la 

placa genera montañas
– Gran cantidad de lluvia estacional

Fuente (izq.): Credit: Nature Geoscience (2017). DOI: 10.1038/ngeo2894; (der.) Handwerger et al., Scientific Reports (2019)

Mud 
Creek

https://arset.gsfc.nasa.gov/
https://phys.org/news/2017-02-atmospheric-rivers-thought.html
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NASA/JPL Uninhabited Aerial Vehicle Synthetic Aperture Radar 
(UAVSAR) (SAR de Vehículo Aéreo No Tripulado)

• NASA Gulfstream III
• SAR de alta resolución

– (0,6 m a lo largo de la dirección de 
vuelo, 1,6m en la dirección del look)

Procesamiento de SAR e inversión de 
series temporales
• InSAR Scientific Computing 

Environment (ISCE) (Rosen et al., 2012)
• Generic InSAR Analysis Toolbox (GIAnT) 

(Agram et al., 2013)
– Método Small Baseline Subset (SBAS) 

(Schmidt and Bürgmann, 2003)

https://arset.gsfc.nasa.gov/
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Deslizamientos en el Norte de California

• Centenares de deslizamientos activos 
en la zona de captura del río Eel

• Vuelos de UAVSAR en 4 líneas
• Las líneas de vuelo fueron 

perpendiculares para obtener 
desplazamientos superficiales 
tridimensionales 

• 11 conjuntos de vuelos entre abril de 
2016 a mayo de 2019

Handwerger et al., JGR (2019)

https://arset.gsfc.nasa.gov/
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Resultados de UAVSAR sobre el Río Eel

Identificación de deslizamientos
• Señal sobre deformación
• Inventarios previamente publicados
• Morfología de los deslizamientos (DEMs)
• Movimiento cuesta abajo
• Google Earth
Inventario de derrumbes
• 312 deslizamientos entre abril de 2016 y 

febrero de 2018
• 102 deslizamientos no mapeados 

anteriormente (es decir, nuevos o 
reactivados)

Handwerger et al., JGR (2019)

https://arset.gsfc.nasa.gov/
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Resultados de UAVSAR sobre el Río Eel

Seguimiento de desplazamiento de pixeles
• Se midió el desplazamiento horizontal a partir del desplazamiento de pixeles
• Se analizaron series temporales de desplazamiento
• El desplazamiento estacional fue impulsado por las lluvias
Handwerger et al., JGR (2019)

https://arset.gsfc.nasa.gov/
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Deslizamientos en el Centro de California

• Datos de Sentinel-1 A/B
• Docenas de deslizamientos 

activos a lo largo de la 
costa central de California

Diapositiva de David Bekaert, P. Agram, H. Fattahi (JPL)

https://arset.gsfc.nasa.gov/
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Deslizamientos en el Centro de California

Deslizamiento de Mud Creek
• Falló de manera catastrófica el 20 de mayo de 2017
• Las reparaciones costaron ~USD 54 millones
• Se combinaron datos de Sentinel-1 y UAVSAR para 

calcular el desplazamiento tridimensional
Sup.: Handwerger et al., Scientific Reports (2019); Inf.: Warrick et al. 2019, https://walrus.wr.usgs.gov/remote-sensing/

https://arset.gsfc.nasa.gov/
https://walrus.wr.usgs.gov/remote-sensing/
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Deslizamientos en en Centro de California

Deslizamiento de Mud Creek

(Izq.) Serie Temporal InSAR de Sentinel 1; (Der.) Handwerger et al., Scientific Reports (2019)

https://arset.gsfc.nasa.gov/
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Deslizamientos en la Costa de Oregón

Deslizamiento de Hooskanaden
• Destruyó la carretera estadounidense 101 cerca de Brookings, Oregón
• Seguimiento de pixeles con datos SAR de Sentinel-1 SAR
• ~6 metros de desplazamiento en la dirección de la línea visual entre el 26 de 

febrero y el 4 de marzo de 2019
(Iza.) Tidewater photo via ODOT del 3 mar. 2019

https://arset.gsfc.nasa.gov/
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Deslizamiento de Slumgullion en Colorado

• Deslizamiento Activo de Slumgullion:
• Velocidad Pico: 1-2 cm/día
• Promedio de la Pendiente: 8 grados
• Largo: 3.9 km
• Grueso: ~300m
• Profundidad: ~14m
• Volumen: 20 x 106 m2

Source: Shulz et al., 2019

https://arset.gsfc.nasa.gov/


31NASA’s Applied Remote Sensing Training Program

Interferogramas de Banda-L de UAVSAR de Slumgullion

• Cuatro direcciones de 
vuelo (flechas verdes)

• Cuatro líneas de 
observación (flechas 
azules)

• Abril 16 y 23 de 2012
• Velocidad en cm/día

Source: Shulz et al., 2019

https://arset.gsfc.nasa.gov/
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Slumgullion: Desplazamiento en 3 Dimensiones

• Combinación de cuatro 
interferogramas de UAVSAR de 7 
días

• Desplazamiento de la superficie 
en 3 dimensiones

• Convertido a velocidad en 
cm/día

• El componente horizontal esta 
ilustrado con colores y vectores

• Paralelo a los deslizamientos 
excepto el mini deslizamiento 
que ocurrió sobre el 
deslizamiento principal

https://arset.gsfc.nasa.gov/
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Slumgullion: Calculación del Ancho del Deslizamiento

Source: Delbridge et al., 2016

Perfil de Velocidad Geometría Basal

https://arset.gsfc.nasa.gov/


Datos SAR para Deslizamientos
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Satélites de SAR

Satélites de SAR En Operación
Ciclo de 

Repetición 
(días)

Longitud de 
Onda (cm)

ERS-1
ERS-2 (Europa)

1992 – 2000
1995–2001 (–2011 limitada) 35 (1, 3, 183) 6

Radarsat-1 (Canadá) 1995-2013 24 6

Envisat (Europa) 2003 – Sep 2010
Oct 2010 – Abr b012

35 
30 6

ALOS (Japón) Jan 2006 – Abr 2011 46 24
Terra SAR-X

TanDEM-X (Alemania)
2007 – actualidad
2010 – actualidad 11 3

Constelación COSMO-SkyMed 
(Italia) 2007 – actualidad 16 (1, 4, 7, 8) 3

Radarsat-2 (Canadá) Dic 2007 - actualidad 24 6

https://arset.gsfc.nasa.gov/
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Nuevos Satelites con SAR

Satélites (lanzados o planificados)) Ciclo de Repetición 
(días)

Longitud de Onda 
(cm)

Sentinel-1 (A: Abr 2014, B: Abr. 2016) 
Europa A: 12, B: 6 6

ALOS-2 (Mayo 2014) Japón 14 24
RISAT-1 (Abr 2012) India 25 6

Misión NASA-ISRO SAR (NISAR) (Ene 2022) 12 12, 24

https://arset.gsfc.nasa.gov/
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Misión NASA-ISRO SAR (NISAR)

• Resolución espacial alta con tiempo 
de revisita frecuente

• Lanzamiento: 2022
• SAR de frecuencia dual de banda-L y 

banda-S
– SAR de banda-L de la NASA y SAR 

banda-S de la ISRO
• 3 años de operaciones científicas (más 

de cinco años de consumibles)
• Todos los datos científicos serán 

gratuitos y puestos a libre disposición
• https://nisar.jpl.nasa.gov
Diapositiva cortesía de Paul Rosen (JPL)

https://arset.gsfc.nasa.gov/
https://nisar.jpl.nasa.gov/


Cómo Acceder, Abrir y Visualizar Datos de SAR 
Interferométrico
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Acceso a Datos de Sentinel-1 para Interferometría

1. Vaya al Alaska Satellite Facility Sentinel Data Portal: https://search.asf.alaska.edu/
• Identifique el área (-121.463489 35.88952, -121.388017 35.88952, -121.388017 35.821763, -

121.463489 35.821763) y las fechas (2016-04-12, 2016-05-6) de su interés (Derrumbe de 
Mud Creek, California, EE.UU.)

1. Identifique imágenes de su interés (Sentinel-1 A/B)
2. Haga clic en More>Additional Filters>File Type> "L1 Single Look Complex (SLC)"
3. Haga clic en More>Additional Filters>Direction> "Descending"
4. Haga clic en Search
5. Seleccione el siguiente gránulo (Granule): 

S1A_IW_SLC__1SSV_20160412T140755_20160412T140823_010789_0101FE_956F-SLC
6. Descargue el producto L1 Single Look Complex (SLC) (2.01 GB)
7. De modo similar, descargue el SLC para el Gránulo: 

S1A_IW_SLC__1SSV_20160506T140756_20160506T140824_011139_010CD3_980D-SLC

https://arset.gsfc.nasa.gov/
https://search.asf.alaska.edu/
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Acceso a Datos de Sentinel-1 para Interferometría

https://arset.gsfc.nasa.gov/
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Abriendo los Datos con el Sentinel Toolbox (Caja de Herramientas)

• Inicie el Sentinel Toolbox (SNAP) haciendo clic en el icono en su escritorio
• En Sentinel Toolbox, vaya al menú de File y seleccione Open Product
• Seleccione la carpeta que contiene su archivo Sentinel-1 SLC y haga doble clic 

en el archivo .zip (no descomprima el archivo; el programa lo hará)

https://arset.gsfc.nasa.gov/
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Abriendo los Datos con el Sentinel Toolbox

• La ventanilla Product Explorer del Sentinel Toolbox 
contiene su archivo.

1. Haga doble clic en el archivo para visualizar las 
carpetas dentro de él, las cuales contienen 
información relevante a la imagen, incluyendo : 

– Metadatos: parámetros relacionados con la 
órbita y los datos

– Cuadrículas “Tie Point”: interpolación de 
latitud/longitud, ángulo de incidencia etc.

– Quicklooks: imagen revisable de toda la escena 
en coordenadas de radar

– Bandas: valores complejos para cada sub-barrido 
“i” y “q” e intensidad (la intensidad es la amplitud 
al cuadrado, una banda virtual)

Los Datos SLC Tienen un Formato Diferente a los de GRDH

https://arset.gsfc.nasa.gov/
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Abriendo los Datos con el Sentinel Toolbox

2. La imagen de Worldview (inf. izq.) 
muestra la huella de la imagen 
entera seleccionada

3. Seleccione la imagen de intensidad 
para el barrido IW1 VV

– Nota: Cada imagen SAR está 
invertida norte—sur porque está 
orientada de la misma manera que 
fue adquirida (trayectoria 
ascendente en este caso)

Visualizando Imágenes de Sub-barridos

https://arset.gsfc.nasa.gov/


Procesamiento InSAR
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Preparación de Datos Interferométricos

1. El primer paso de la interferometría es 
corregistrar dos imágenes SLC

2. En el menú de la barra superior, seleccione 
Radar > Coregistration > S1 TOPS 
Coregistration > S1 TOPS Coregistration 
nuevamente

Corregistrando las Escenas

https://arset.gsfc.nasa.gov/
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Preparación de Datos Interferométricos

3. En la pestaña Read, seleccione el SLC 
20160412 SLC y en la pestaña Read(2)
seleccione el SLC 20160506

4. En las pestañas TOPSAR-Split y TOPSAR-
Split(2), seleccione Subswath: IW2 
Polarisations: VV

5. En la pestaña Back-Geocoding- SRTM 1sec 
HGT (auto download)

6. En la pestaña Write, seleccione la carpeta 
donde quiere guardar los resultados de su 
procesamiento

Corregistrando las Escenas

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico

1. El segundo paso de la interferometría es hacer un 
interferograma a partir de las imágenes SLC 
corregistradas

2. En el menú de la barra superior, seleccione Radar, 
luego Interferometric, luego Products y después 
Interferogram Formation

3. En la pestaña I/O Parameters, seleccione el 
producto “Orb_Stack” creado por el paso de 
corregistración

– Por defecto, el archivo de salida está en la 
misma carpeta y se la agrega “ifg” al nombre

– Para un procesamiento básico, no hay 
necesidad de cambiar las configuraciones 
preprogramados en la pestaña Processing 
Parameters

Formando un Interferograma Bruto

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico

1. Combine todos los datos de las tomas (bursts) 
en una sola imagen, aplique el operador 
TOPS Deburst desde el menú Sentinel-1 TOPS.

2. En el menú de la barra superior principal, 
seleccione Radar, luego Sentinel-1 TOPS, 
luego S1 Tops Deburst, 

3. En la pestaña I/O Parameters, seleccione el 
“ifg”

TOPS Deburst*

*El “debursting” o “deburst” es una operación que consiste en generar una imagen 
continua en cuanto al tiempo del azimut removiendo líneas negras de separación 
así como líneas redundantes entre tomas

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico
Visualizando un Interferograma Bruto — Imagen de Fase

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico

1. El siguiente paso para toda interferometría 
es remover la fase topográfica mediante 
un DEM.

2. En el menú de la barra superior, 
seleccione Radar > Interferometric > 
Products > Topographic Phase Removal

Remoción de la Fase Topográfica

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico

3 En la pestaña I/O Parameters, seleccione 
el producto “Orb_Stack_ifg_deb” que se 
creó en el paso de deburst o “Stack_ifg” si 
no está en modo TOPS

– Por defecto, se le agrega “dinsar” al 
nombre del producto de salida

– La pestaña Processing Parameters
muestra que la configuración 
preprogramada es descargar el SRTM 3-
arcsecond DEM, el cual sirve para un 
preprocesamiento básico, pero puede 
que necesite el SRTM 1-arcsecond DEM 
para obtener una mejor resolución

Remoción de la Fase Topográfica

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico

1. Hay dos pasos que pueden reducir el nivel de ruido en un interferograma, la 
filtración y el multi-looking. Primero aplicamos la filtración, pero también se 
puede hacer el multi-looking primero.

2. En el menú de la barra superior, seleccione Radar, luego Interferometric, luego 
Filtering, y después Goldstein Phase Filtering

– En la pestaña I/O Parameters, seleccione el producto “ifg_deb” creado en el 
paso anterior

– Por defecto, al archivo de salida se le agrega “flt” al nombre
– Para el procesamiento de derrumbes, es mejor cambiar los valores 

preprogramados en la pestaña Processing Parameters

Filtración y “Multi-Looking” de Interferogramas

https://arset.gsfc.nasa.gov/
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3. “Multi-looking” significa calcular el promedio a varios pixeles en cada dirección, 
lo que los ingenieros de radar llaman “darle varias miradas” o varios “looks”. El 
resultado son pixeles más grandes y éstos pueden reducir la cantidad de ruido de 
manera significante. 

– La cantidad de multi-looking que se debe hacer depende de la resolución 
espacial que uno necesita y el espaciamiento de las franjas

– Por lo general, los derrumbes son pequeños a comparación con la resolución de 
Sentinel-1, así que haga menos multilooking que para otros aplicaciones de 
InSAR

Filtración y “Multi-Looking” de Interferogramas

https://arset.gsfc.nasa.gov/
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1. El derrumbe de Mud Creek mide ~500 de largo 
y ~500 m de ancho

2. En el menú de la barra superior, seleccione 
Radar luego SAR Utilities y luego Multilooking

– En la pestaña I/O Parameters, seleccione el 
producto “ifg_deb_flt creado por el paso de 
filtración y por defecto al archivo de salida 
se le agrega “ML” al nombre

– En la pestaña Processing Parameters, 
seleccione Source Bands “i_ifg”,“q_ifg” y 
“coh”. Para esta escena, normalmente utilizo 
4 looks del rango y 1 del azimut para 
producir pixeles con ~14 m  de resolución

– No seleccione las bandas “Phase” o “Intensity”!

Interferograma por Multi-Looking

https://arset.gsfc.nasa.gov/


55NASA’s Applied Remote Sensing Training Program

Procesamiento Interferométrico

1. Primero, debemos hacer una nueva banda de 
fase virtual después de realizar el “multi-
looking” del interferograma complejo

2. Seleccione la banda i_ifg_VV o q_ifg_VV 
3. En el menú de la barra superior, seleccione 

Raster, después Data Conversion y luego 
Complex i and q to Phase

4. Ahora puede visualizar la nueva banda de 
fase

• Las franjas tienen mucho menos ruido
• La relación de aspecto ha cambiado así que los 

pixeles son casi cuadrados

Visualizando Interferogramas Multi-Look

https://arset.gsfc.nasa.gov/
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Preparación de Datos Interferométricos

1. Para analizar un derrumbe en 
particular, puede crear un 
subconjunto alrededor del área de 
interés. Esto le ahorrará tiempo de 
desenrollamiento y después en el 
procesamiento.

2. Haga clic en Raster > Subset > Geo 
Coordinates > ingrese "North: 35.89, 
South: 35.82, West: -121.46, East: -
121.39"

Creando un Subconjunto

https://arset.gsfc.nasa.gov/
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• Instrucciones de instalación y uso:
– Este plugin ahora está disponible bajo plugins para SNAP. El plugin SNAPHU 

Unwrapping puede ser instalado desde Tools > Plugins > Available Plugins.
• Elija el plugin, haga clic en “Install” y siga el proceso de instalación. Reinicie SNAP 

cuando termine la instalación de SNAPHU Unwrapping.
• Una vez que se instale el plugin, estará disponible bajo Radar > Interferometric > 

Unwrapping > Snaphu-unwrapping* 
– * Cuando utilice la herramienta de desenrollamiento SNAPHU Unwrapping por 

primera vez, recibirá una notificación de que es necesario configurar una ruta 
operativa para el plugin

– Haga clic en OK y proceda con la descarga e instalación del paquete
– Después de estos pasos, el plugin estará listo para ser usado. En Linux, después de la 

instalación del plugin, asegúrese de agregar el permiso de ejecución en snaphu script 
bajo $HOME/.snap/auxdata/snaphu-v1.4.2_linux/bin antes de empezar a utilizar el plugin.

Desenrollamiento de la Fase: El plugin SNAPHU para SNAP

https://arset.gsfc.nasa.gov/
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• Antes de desenrollar un producto, hay que exportarlo utilizando Snaphu Export
– Radar > Interferometric > Unwrapping >Snaphu Export

• Cuando termine la exportación, se puede ejecutar el desenrollamiento de 
Snaphu Unwrapping
– Radar > Interferometric > Unwrapping > Snaphu-unwrapping

Desenrollamiento de la Fase

https://arset.gsfc.nasa.gov/
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• En la primera pestaña, seleccione el producto previamente exportado con 
Snaphu Export (ej. Phase.hdr)

• En la pestaña de parámetros, seleccione la carpeta para la salida
– Para poder abrir el producto desenrollado, es obligatorio seleccionar como 

carpeta para la salida la misma carpeta donde se encuentran los archivos que 
exportó (ej. phase.img, snaphu.conf etc.)

– También puede fijarse bajo “Display execution output” para poder visualizar el 
historial y el proceso de desenrollamiento. 

• Ahora haga clic en “Run”
• Después de que se desenrolle la fase, la puede importar a SNAP para ser 

analizada utilizando Radar > Interferometric > Unwrapping > SNAPHU Import (para 
utilizar el producto desenrollado en SNAPHU Import, asegúrese de haberlo 
guardado antes)

Desenrollamiento de la Fase

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico

• SNAP 6.0 no incluye desenrollamiento de la fase. 
Tiene una forma de exportar interferogramas para 
desenrollar con el programa tercerizado Snaphu 
(Statistical-cost, Network-flow Algorithm for Phase 
Unwrapping) de Chen y Zebker.

1. En el menú de la barra superior, seleccione Radar > 
Interferometric > Unwrapping > Snaphu Export.

2. En la pestaña Read, seleccione el producto “ML” 
creado por el paso del multilooking

3. En la pestaña Snaphu Export, cambie el modo 
Statistical-cost a “SMOOTH”

4. También cambie el número de filas y columnas de 
tejas y el número de procesadores a “1” porque no 
necesitamos tejas múltiples después del multilooking y 
la creación de subconjuntos. 

Desenrollamiento de la Fase

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico

5. En la pestaña Snaphu Export, también debe  
especificar una carpeta de destino para sus 
archivos exportados. Yo puse los archivos de 
Snaphu en una carpeta separada (la que aquí 
llamé “snaphu_unw”), así que debe crear una 
carpeta por medio del diálogo de selección o en 
otra ventanilla.

6. La ventanilla de diálogo de Snaphu Export que 
aparece no funciona del todo bien con SNAP 7.0 
en MacOS. Una solución:

– Navegue a la carpeta que incluye la carpeta 
“snaphu_unw”

– El botón “select” no funcionará para seleccionar 
la carpeta “snaphu_unw”

– Escriba “snaphu_unw” en la casilla File: en la 
parte superior y después haga clic en Select

Desenvolvimiento de Fase

https://arset.gsfc.nasa.gov/


NASA’s Applied Remote Sensing Training Program 62
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7. Ahora puede hacer clic en el botón Run y SNAP exportará la fase y coherencia 
del interferograma con un archivo “snaphu.conf”

8. Ahora importamos la fase desenrollada. En el menú de la barra superior, 
seleccione Radar, luego Interferometric, luego Unwrapping y después Snaphu 
Import.

9. La pestaña Read-Phase debería estar configurada para el producto que usted 
exportó. 

Desenrollamiento de la Fase

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico

10. En la pestaña Read-Unwrapped-
Phase, seleccione el producto 
desenrollado:

– Navegue a la carpeta a la que 
exportó para Snaphu

– Seleccione el archivo 
“UnwPhase_ifg*.snaphu.hdr”

11. Vaya a la pestaña Write y revise el 
nombre de salida del producto (yo le 
agrego ”_unw” al nombre del 
producto enrollado para obtener un 
nuevo producto)

Desenrollamiento de la Fase

https://arset.gsfc.nasa.gov/
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Procesamiento Interferométrico

12. Finalmente podemos visualizar la fase 
desenrollada

13. Seleccione la banda Unw_Phase_ifg
14. Vaya a la pestaña Colour Manipulation

y seleccione “95%” para estirar la escala 
cromática y luego ajuste los deslizadores 
para mostrar mejor el derrumbe

– La fase desenrollada sigue en radianes
– La fase es la imagen de referencia 

menos la imagen corregistrada. Si la 
imagen de referencia es anterior a 
esta, la fase negativa significa que el 
suelo se mueve hacia el satélite 
(cambio de rango negativo)

Desenrollamiento de la Fase

https://arset.gsfc.nasa.gov/
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1. Podemos convertir la fase 
desenrollada en desplazamientos. En 
el menú de la barra superior, 
seleccione Radar, luego
Interferometric, luego Products y 
después Phase to Displacement.

– La pestaña I/O Parameters debe 
contener el producto desenrollado 
que importó. 

– por defecto, se le agrega “_dsp” al 
nombre del producto nuevo

Conversión de Fase a Desplazamiento

https://arset.gsfc.nasa.gov/
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2. Ahora podemos visualizar la banda 
displacement resultante. Nuevamente, 
es mejor estirar los colores.

– El desplazamiento está en metros. 
– El signo cambió así que el 

desplazamiento positivo es hacia el 
satélite (arriba o hacia el Este en 
este recorrido)

Conversión de Fase a Desplazamiento

https://arset.gsfc.nasa.gov/
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1. SNAP hace la geocodificación con topografíapor 
medio de “Terrain Correction”. En el menú de la 
barra superior, seleccione Radar, luego Geometric, 
luego Terrain Correction, y luego Range-Doppler 
Terrain Correction.

– La pestaña I/O Parameters debe contener el 
producto de desplazamiento que importó (o algún 
otro de los productos ML). 

– por defecto se le agrega “_TC” al nombre del 
archivo de salida

– Bajo la pestaña Processing Parameters, seleccione 
Source Bands y cualesquiera Output Bands
adicionales. También puede elegir el DEM (SRTM 
1Sec HGT es en realidad 1 arcosegundo o 30 m), 
espaciado de salida (15 m) y proyección 
cartográfica.

Resultados de Geocodificación—Corrección por Terreno

https://arset.gsfc.nasa.gov/
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1. Ahora podemos visualizar la banda 
displacement_vv del resultado 
geocodificado. Nuevamente, es mejor 
estirar los colores.

– Los desplazamientos están en metros 
con valores positivos significando 
hacia el satélite en la dirección de la 
línea de observacion (arriba o hacia 
el este).

– El producto ahora está espaciado 
de manera uniforme en latitud y 
longitud de aproximadamente 15 
metros (1.35x10-4 grados).

Resultados de Geocodificación—Corrección por Terreno

https://arset.gsfc.nasa.gov/
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